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1 Welcome  
Congratulations on your purchase of the StorageQuest R EFLECTOR  Network 

Backup and Archive Manager. This software system makes it possible for multiple users 

anywhere in a Windows Workgroup to create optical discs using a shared Primera disc 

publisher. 

This document will assist you with installing, configuring, and using R EFLECTOR . 

You also have two additional sources of information:  

 While you are running REFLECTOR  software, you can take advantage of our 

online help system. 

 We invite you to send your questions to us at support@StorageQuest.com. 

StorageQuest is committed to making your REFLECTOR  experience outstanding 

and welcomes your feedback. 

1.1 Overview 

REFLECTOR  Server Edition is the Network Backup & Archive Manager specifically 

designed to support the complete line of Primera CD & DVD duplication hardware, 

expanding their functionality to now deliver automated, reliable, cost-effective backup 

and archive protection for Small and Medium Businesses (SMBs) and the distributed 

enterprise.   

This unique combination of software and hardware enables businesses to utilize industry 

standard optical media for all of its backup and archiving requirements. Features like 

automated backup of servers and workstations, optimization of data recording to reduce 

the number of discs required for a job, seamless spanning of files which are larger than 

a single piece of media and the automatic printing of labels for all media, provide 

businesses with greater ease of management and higher availability of their data.  

The REFLECTOR  Client Pac is an optional software application which requires the 

R EFLECTOR  Server Edition to be installed on a Primera server network.  The Client 

Pac is designed for users needing the power and functionality of the Server Edition at 

their desktops.  Users can push data files to a Primera server which is especially useful 

with applications such as video editing, digital imaging or any application where large 

amounts of data must be moved off primary storage to free up capacity for the next job.  

Multiple users, each with a copy of REFLECTOR  Client Pac, can share a single 

Primera system that serves all the computers of a networked Windows Workgroup. 

The Primera disc publisher includes one or more drives for reading and writing optical 

discs, a printer to label the top surface of those discs, and a robotic mechanism to 

automatically feed blank discs from the recorder, then to the printer, and finally to an 

output stack. 

mailto:support@StorageQuest.com
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With REFLECTOR , you specify which files you wish to write to CD or DVD, on a 

single or recurring basis for system backup. The REFLECTOR  software 

automatically creates multiple CDs or DVDs as necessary, with each disc clearly 

labeled.  

You can also use the REFLECTOR  software to restore some or all of the files from a 

CD or DVD to your computerôs hard disk. 

1.1.1 Parts of a REFLECTOR  System 

REFLECTOR  consists of software that runs on one or more computers of a 

networked Windows Workgroup. REFLECTOR  is compatible with Microsoft Windows 

2000/XP and newer versions of Microsoft Windows. 

Though REFLECTOR  software requires Microsoft Windows, it can be used to 

backup network-shared drives on computers that are running other operating systems. 

1.1.2 Parts of This Manual 

This manual has two main parts. 

 The first part tells you how to set up the REFLECTOR  software 

 The second part describes how to use REFLECTOR  to save your data to optical 

disc, how to label your discs, and how to restore information you have saved. 

1.2 Contacting StorageQuest 

1.2.1 Mailing Address 

 StorageQuest, Inc. 

 226 Argyle Avenue 

 Ottawa Ontario 

 Canada K2P 1B9 

1.2.2 Phone and Fax 

 Phone:  (613) 235-6919 

 Fax:  (613) 235-1785 
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1.2.3 On the Web 

 Website:  http://www.StorageQuest.com 

 E-Mail (Support): support@StorageQuest.com 

 E-Mail (Sales): sales@StorageQuest.com 

http://www.storagequest.com/


User Manual  
 

 4  

2 Setting Up Your System  

2.1 Installing the Primera System 

Follow the instructions in the Primera manual to install the Disc Publisher hardware and 

software provided by Primera.  

 Since your Primera system requires a host computer, connect it to the host using 

USB and install the Primera server software on the host computer. Connect the host 

computer to the LAN.  

Primera also supplies the SureThing CD Labeler program, which can be used to design 

custom labels that will be printed on CDs and DVDs by the Primera printer. 

 You can use this program to design common label layouts, and distribute the label 

definition files (.std) to each REFLECTOR  user. 

 You can also install SureThing CD Labeler software on each computer licensed to 

use Primera and StorageQuest software. 

2.1.1 Installing the Primera PTBurn Server 

The Primera system requires the PTBurn server component to be installed on Primera 

Server.  This software provides the network connectivity required by REFLECTOR .  

To install the PTBurn software, run SETUP_PTBURN.EXE from the REFLECTOR  

Installation CD and follow the installation procedure to setup the software. 

2.2 System Requirements 

To use the REFLECTOR  Network Backup & Archiving Manager for Primera, you will 

require the Minimum System configuration: 

 Windows 2000Êor Windows XPÊ 

 1.5Ghz Processor 

 256 MB System Memory 

 Network Interface Connection 

 CD/DVD Drive 

 At least 10 GB Available Free Disk Space (see 2.2.1 -  Disc Space Requirements for 

details) 

 A supported Primera System (Bravo II, Pro, XR, XRP) 

 A dedicated computer is recommended for running the PTBurn Server software 
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2.2.1 Disc Space Requirements 

The hard disk space requirements for the Primera Server with a single REFLECTOR  

user creating Primera CDs or DVDs can be determined as follows: 

 

Hard Disc Space Needed 

Normal Mode = (Number of discs + 1) x (Size of media) 

Number of discs: The maximum number of unique discs submitted at the 

same time from the REFLECTOR . 

Size of media: For CD this is 650 MB, DVD is 4500 MB 

PowerStream Mode = (PowerStreams + 1) x (Size of media) 

PowerStreams: PowerStreams for REFLE CTOR  client (Default 4) 

2.3 Server Edition and Client Pac 

The REFLECTOR  Server Edition licensing model is hierarchical in that a specific license 

is required for each Primera model that you are connecting to since REFLECTOR  is 

licensed to a specific Primera hardware model or models.   

The REFLECTOR  Client Pac is an optional software application and requires the 

REFLECTOR  Server Edition to be installed on a Primera server network.  The Client Pac 

is designed for users needing the power and functionality of the Server Edition at their 

desktops.  Users can push data files to a Primera server which is especially useful with 

applications such as video editing, digital imaging or any application where large amounts of 

date must be moved off primary storage to free up capacity for the next job.  Multiple users, 

each with a copy of REFLECTOR  Client Pac, can share a single Primera system that 

serves all the computers of a networked Windows Workgroup.  Contact StorageQuest or 

your reseller to purchase additional licenses. 

2.4 Installing the Software 

To install REFLECTOR , load the REFLECTOR  software CD into your computerôs 

optical drive then use the Windows Explorer to navigate to the REFLECTOR  folder 

on the software CD. Double click on the Setup.exe program icon. The Installation Wizard 

will guide you through the simple process of installing the REFLECTOR  software. 

You donôt have to install the REFLECTOR  Server Edition on the same 

server as the Primera hardware ï it can be installed anywhere on your 

network! 
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Figure 1 illustrates a typical configuration with multiple REFLECTOR  users sharing 

one Primera disc publisher, which is attached to a server computer. 

 

Figure 1: Typical REFLECTOR  Configuration 

2.4.1 Activating your Software 

When initially installed, the REFLECTOR  software operates in a trial mode for a 

maximum of 14 days. To continue to use the REFLECTOR  software, you need an 

individual license for each computer that runs REFLECTOR , even if those computers 

share the same Primera disc publisher. To purchase a license: 

 Start the REFLECTOR  software on your computer. 

 When the introductory screen appears, press the Return key and follow the 

instructions that are presented. The REFLECTOR  software will calculate a Site 

Code that you will send to www.StorageQuest.com/Activate  

 After you have paid for the REFLECTOR  software, enter the activation key that 

StorageQuest sends to you in an email. This key will be valid only for the same 

computer on which the Site Code was generated. 

 NOTE: DO NOT Uninstall the software if you need to fix a problem. Uninstalling 

the software will destroy your license key. Contact your reseller or 

StorageQuest if you need assistance. 

2.5 Choosing Blank Optical Discs 

Be sure to use only blank DVDs or CDs that are compatible with your model of Primera 

hardware. Read your Primera documentation for details. The instructions here apply to 

most models but yours may have specific requirements. 

 

 

http://www.storagequest.com/Activate
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2.5.1 CD or DVD 

First, choose whether to save your data to CDs or DVDs.  

 Some Primera disc publishers can write only CDs. Others also write DVDs. 

 A full DVD holds about as much as seven full CDs. A blank write-once DVD costs 

about the same as a blank write-once CD. 

 Some optical drives can read only CDs and not DVDs. If you want to read your discs 

in a CD-only optical drive, you should use blank CDs.  

 Most writeable CDs hold about 700 Mbytes, but some hold only 650 Mbytes. Use the 

pop-up CD Size button at the top of the REFLECTOR  main window to select the 

correct size for the CDs you are using. 

2.5.2 Write-once or Erasable 

Second, choose write-once or erasable blank discs.  

 Write-once blank CDs are labeled CD-R. Write-once DVDs are labeled as either 

DVD-R or DVD+R; chose a format compatible with your Primera hardware. Once a 

write-once disc has been written, there is no way to add more data to it or to reuse it 

for different data.  

 Erasable blank CDs are labeled CD-RW. Erasable blank DVDs are labeled as either 

DVD-RW or DVD+RW; chose a format compatible with your Primera hardware. 

When an erasable disc has been written there is no way to add more data to it, but it 

is possible to completely erase it and use it again.  

 Erasable discs cost more than write-once discs, have a slower maximum writing 

speed, and cannot be read by some optical drives. They are seldom the best choice 

for archival data, but may be useful for temporary storage. 

2.5.3 Printing Surface 

Third, choose printable blank discs if you will be printing labels on them. 

 Primera models feature an ink jet printer can print only on inkjet-printable discs with a 

special matte white top surface.  

 Most printable discs are write-once. If you are using erasable discs that cannot be 

printed by your Primera disc publisher, be sure to label them using a marker pen 

designed for CD and DVD labeling. Never use a ballpoint pen. 
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2.5.4 Loading the Primera Disc Publisher 

Most models of Primera Disc Publisher hold two stacks of blank discs, usually CD or 

DVD, and an output bin. Ensure that the Disc Publisher is loaded with the correct blank 

discs. 

2.6 Basic Operation 

REFLECTOR  makes it easy to write and label CDs and DVDs using a Primera Disc 

Publisher.  

 You can choose files and folders to save, or you can specify simple rules to select 

files and folders. 

 The REFLECTOR  software automatically writes as many discs as your files 

require, and can split large files across multiple discs.  

 REFLECTOR  also allows you to define which files you want to backup, and then 

use that definition repeatedly to save the latest versions of your files. 

 You can print labels on the discs, with attractive graphics and titles to properly 

identify each disc. The titles can contain variable information such as the date, time, 

and user name or computer name. 

For detailed instructions see Chapter 3 ñCreating CDs and DVDsò, Chapter 4 ñBacking 

Up and Restoring Filesò, and Chapter 5, ñLabeling Your Discsò. 

2.6.1 Backing up Macintosh Computers 

REFLECTOR  is a Windows program that can backup any file or folder visible in a 

Windows workgroup. Many operating systems, including Macintosh OS X, are able to 

share files with Windows computers.  

 To backup files from a Macintosh computer, turn on Windows File Sharing in the 

Macintosh computerôs Sharing Control Panel. In the Browser panel of 

REFLECTOR , select Network Shares then browse to find the Macintosh 

computer by name. Click on its icon to see which shares are accessible. 

 You will then be able to select for backup any files or folders that have been made 

available for sharing on the Macintosh.  

Many other operating systems also provide file sharing for Windows workgroups. 
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3 Creating CDs and DVDs  
There are two basic ways to create CDs and DVDs - by using the Backup Wizard, or by 

using the REFLECTOR  main window.  

 The Backup Wizard is the simplest way to define backup operations that you want to 

perform repeatedly. You can easily backup all or part of your programs and your 

data, using as many CDs or DVDs as necessary. See Section 4.1. 

 The REFLECTOR  main window is the easiest way to create a simple data CD or 

DVD. It also offers optional advanced features that go beyond the capability of the 

Backup Wizard. 

 Whichever way you create your discs, it is easy to restore your files and folders, 

either completely or selectively (see Section 4.2). 

3.1 Creating a Data CD or DVD 

This section explains how to use REFLECTOR ôs main window (see Figure 2) to 

quickly save folders or files to optical disc. Following sections describe advanced 

features such as scripts and filters. 

 

Figure 2: REFLECTOR  Main Window 
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3.1.1 Choose CD or DVD Output 

Click the Primera CD or Primera DVD mode tab and ensure that the correct blank discs 

are loaded in your Primera Disc Publisher. If you have chosen Primera CD, use the pop-

up CD Size button in the Volume Info to select the correct capacity for the blank CDs 

you are using. If you are not sure of the size, use the default 650 Mbytes. 

3.1.2 Select Files and Folders 

In the REFLECTOR  Filters menu, select ñTurn Off All Filtersò. See Section 3.2.2 if 

you want to use filters. 

Simply drag the files and folders that you want to save to the Destination pane. It always 

lists the files that will be saved when you write your optical discs. 

 To save entire folders with their contents (including files and folders inside the folders 

you select), drag the folders from the Browser pane to the Destination pane. The 

names of all files that will be saved appear in the Destination pane.  

 To save chosen files from a folder, first select the folder in the Browser pane, or drag 

it to the Source pane. In the Source pane, REFLECTOR  displays all the files and 

folders inside the folder you have selected. Drag the files or folders you want to save 

to the Destination pane, or select them in the Source pane and click the Add button 

above the Destination pane. 

 To remove files from the Destination pane, so that they will not be saved to optical 

disc, select them in the Destination pane and click the Remove button above the 

Destination pane. 

REFLECTOR  lists only files, not folders, in the Destination pane. However, it keeps 

track of the original location of every saved file, and can restore both files and folders. 

The Volume Information area at the top of the REFLECTOR  window shows you how 

many optical discs will be needed to hold the files you have selected. You can choose to 

make multiple identical copies of each disc if you wish. 

3.1.3 Label your Discs 

Each of your discs can have two kinds of label: the Windows volume label that will be 

written to the optical disc and a printed label on the top surface of the disc. 

 Use the Volume Name field at the top of the REFLECTOR  window to give each 

optical disc a name that will remind you of its purpose when you see the mounted 

disc in Windows Explorer. It may be helpful to include your name and the date in the 

volume name.  

 Use printed labels to help identify discs for easy retrieval of their contents. See 

Chapter 5. 
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3.1.4 Publish your Discs 

Click the Create Data CD button (or Create Data DVD if you have chosen DVD output) 

to send the files you have selected to the Primera Disc Publisher. 

In the Primera Disc Properties dialog that appears (Figure 15) you can click in a check 

box to select Simulated Write. Simulation is useful when you are testing the software, 

but do not yet wish to write actual optical discs or print the labels. 

3.1.5 Check Disc Status 

Click on the Primera Status mode tab (see Figure 2) to view the status of your disc 

publishing job. Your job may be in progress, or completed, or queued waiting for 

completion of other jobs that were submitted ahead of it. 

To cancel a waiting job, right-click on its entry in the job queue and select the 

appropriate option in the pop-up menu. 

3.2 Optional Features 

The options described in this section give you more control over the discs you create, 

but are not necessary for basic operation. 

3.2.1 Selecting REFLECTOR  Options 

The Options dialog, available in the REFLECTOR  Tools menu, provides a wide 

range of control over REFLECTOR  operation. Click in the left panel to select a group 

of options, then select options in that group using the right panel. Only a few important 

general options are described here. 
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Figure 3: General Options 

The default settings of these options, shown in Figure 3, are suitable for most purposes. 

 REFLECTOR  generates sequential disc volume numbers for all CDs and DVDs 

written by a particular REFLECTOR  user. Current Volume Number indicates 

what number will be used for your next disc. 

 HTML index files are essential if you wish to be able to browse the file and directory 

structure of your discs to selectively restore files. 

 Whenever you modify any file or folder, Microsoft Windows sets the ñArchive Bitò 

associated with that item. If you have checked this option, REFLECTOR  will clear 

the Archive Bit of each file and folder after writing it successfully to optical disc. You 

can then choose to backup only changed files by specifying Archive Bit in a filter (see 

Section 3.2.2). 

3.2.2 Filters 

You can specify filters that either select or reject files or folders by name, date, or 

Archive Bit status. The filters work in two stages: first any Include filters select desired 

files or folders, and then any Exclude filters eliminate unwanted files or folders from the 

initial selection.  

 By default, if you do not specify any Include filters, all files and folders are included. 

 Include filters are often used to create optical discs that contain only a particular 

category of files, such as digital photos (*.jpg) or music (*.mp3). 

 If you have already saved the same kind of files to optical disc on an earlier 

occasion, you may wish to use an Exclude filter based on date or Archive Bit to avoid 

saving the same files again. 
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Select the Filter Editor in the REFLECTOR  Filters menu to create, modify, and 

choose filters. Figure 4 shows the creation of a new filter. 

 Use a descriptive name that will remind you of the purpose of this filter. 

 You can choose to make the filter include or exclude either files or directories 

(folders). 

 Filtering by name is just like filtering by name in the Backup Wizard (see Section 

4.1). 

 Filtering by Archive Bit Set allows you to choose only files modified since the last 

REFLECTOR  run.  

 Date filters can specify a range of dates, or a first or last date of interest. 

 

Figure 4: Adding a Filter 

 

Filters that you create in the filter editing screen will be available for you to choose from 

when creating backup jobs.  They can also be made active or inactive while using the main 

interface.  An active filter is represented on the Filter menu with a checkmark, and clicking 

the filter item in the menu will toggle its status.   Note that the filterôs active status for use 

with the main interface is independent of its use with a backup job. 

To further understand the filtering system, you might consider experimenting with it by 

creating some test filters and then adding some files to a set to observe what happens.  For 

example, create a filter that includes files whose type is a Microsoft Office document, and 

then add your C drive to a set.  When all the files are finished processing, you will notice that 

the destination list contains only Microsoft Office files. 
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In addition to the advanced filtering, you can also take advantage of the quick filter tool 

when using the main interface.  Located in the bottom left corner of REFLECTOR , the 

quick filter behaves like one big include filter while adding files to a set.  You can have files 

filtered by one or more of the following properties: File name (including wildcards), Date 

modified, created or accessed, Type by Category, Size, and Advanced.  

When adding files to a set, if one or more quick filters are active, the file must match all of 

the filters before it is added.  For example, if you select the size and type quick filters, setting 

the size to be at least 100kB and the type to be Microsoft Office, then only files that are both 

of these things (i.e. a Microsoft Office file that is larger than 100kB) will be added.  This is 

the opposite behavior you find in advanced filtering where a file must match any one include 

(i.e. a Microsoft Office file, or any file which is larger than 100kB). 

If you are using advanced filtering and quick filtering at the same time, you will find that the 

quick filter is applied to the files first, and any files that pass the quick filter are then passed 

through any currently active advanced filters.  Any files that then pass the advanced filters 

are finally added to the destination set. 

Also note that filtering does not affect files that are already in your destination set, only new 

files as they are added.  This means that you can activate, deactivate, and update your 

filters as you go, to build a completely customized set. Please note that unlike advanced 

filters, quick filters are not recorded by the script recorder. 

3.2.3 File Type Categories 

A fileôs ñtypeò is identified by its extension.  File extensions are generally 3 characters long, 

and follow the last period in a file name.  For example, using somefile.txt as a filename, the 

ñtxtò at the end is its extension, and this particular extension denotes a text file.  File 

extensions donôt always match their description phonetically, and Windows does not always 

show you the extension on a file, opting instead to show you a representative icon. 

File types can also be represented by logical categories, for example, ñImage Filesò could 

contain JPEG, GIF, BMP, TIFF, PNG, and others as they are all images. 

Filtering by file type category can greatly simplify making comprehensive data sets.  For 

example, you can easily have REFLECTOR  search out the entire network for all Office 

documents. 
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Figure 5: Quick Filtering by File Type Category 

 

Another powerful feature of file type categories is that you can define your own categories 

containing any number of any file types at all.  You can use this feature to create a category 

containing all the different types of files that are important to your organization. 

You can use file type categories anywhere that you can use filtering in REFLECTOR .  

Just select ñFile Typeò as your filter type, and then choose a category.  Additionally, in each 

location where you can implement file type filtering, you will find a link to open up the file 

type category manager.  This manager can also be accessed from the Edit menu on the 

main screen.  From the manager, you can examine each category that is defined in 

REFLECTOR , and all the file types that make up that category.  You can freely add and 

delete types from a category, and you can create or delete entire categories. 
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Figure 6: File Type Category Manager 

 

When adding a type to a category, you will be shown a list of all the file types currently 

known to your computer.  If the type you wish to add is not in that list, you can manually 

enter the file extension you need. 

3.2.4 Scripts 

You may want to save the same kinds of files and folders to optical disc on more than 

one occasion. One way is to use the Backup Wizard (see Section 4.1). Another is to use 

the main REFLECTOR  window, with its more powerful filter capability, and record the 

specification as a script that you can use repeatedly. 

To use an existing script, choose ñOpen Script ...ò in the REFLECTOR  File menu. 

To create a new script, choose ñRecord Scriptò in the File menu, and then go about your 

business changing disc modes, adding files, and so on.  As you work, you will see your 

actions appearing in the script recorder window.  When you have finished selecting the files 

and folders to save and would be ready to start burning discs, end the script. 

 A Script Recorder window appears, as shown in Figure 7. As you select files and 

folders, and specify filters, the details are recorded in the script. 

 Click either the End Script button at top left, or the Stop Recording button in the 

Script Recorder window, to stop recording the script and save it for use. 

 If you want to specify label settings and/or a description for the volumes, use the end 

script button in the top left, which will open the create disc dialog allowing you to set 

anything you like.  Click Create when finished, and the script will be saved. 
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Figure 7: Recording a Script 

 

Scripts are saved as ordinary text files, and the commands in them are simple to 

understand. It is easy to use any text editor such as Notepad to update a script that 

needs minor changes. 

For more information on scripts see Section 6. 
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4 Backing Up and Restoring Files  
The simplest way to backup your data is to use the Backup Wizard. The Wizard includes 

a convenient option to create an automatic backup schedule, such as a weekly full 

backup plus daily backups with only changed files. 

You can also select files and folders directly in the REFLECTOR  main window and 

send them to the Primera disc publisher as described in Section 3.1. This gives you 

access to a wider range of file selection filters than the Wizard offers. You can save a 

backup definition as a named script file to use repeatedly. 

The simple procedure for restoring files is described in Section 4.2. 

4.1 Using the Backup Wizard 

Select the Backup Wizard using the REFLECTOR  Tools menu. 

On the first page of the Backup Wizard (see Figure 8), choose whether to define a new 

backup or run a previously defined backup. The rest of this section assumes that you 

have chosen to create a new backup. 

 

Figure 8: Backup Wizard 

On the second page (Figure 9), give your new backup a name and specify its basic 

characteristics. 


